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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted at www-odp.tamu.edu/publications/.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for the Ocean Drilling Program, Department of Primary 
Industries and Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean 
Institute for Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Italy,
The Netherlands, Norway, Portugal, Spain, Sweden, Switzerland, and Turkey)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

National Science Foundation (United States)
Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Current policy requires that all figures published in Scientific Results volumes of the Proceedings of the 
Ocean Drilling Program be provided by the authors.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

http://www-odp.tamu.edu/publications/
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This volume includes a site map showing the drilling locations for this leg and maps showing the 
drilling locations of all Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling 
sites in PDF format. These maps were produced using Generic Mapping Tools (GMT) of Paul Wessel 
and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph is of the JOIDES Resolution.

http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 

Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 18 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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PREFACE

THE VOYAGES OF DISCOVERY

The Scientific Results volumes of the Proceedings of the Ocean Drilling Program are about Earth and her oceans.

These volumes contain contributions to a better understanding of the history of our planet through time. This 
exploration of Earth’s past is based on scientific analyses of layers of strata sampled by the JOIDES Resolution at 
key locations throughout the global ocean. These volumes are a tribute to the scientific exploration carried out 
by the men and women who contributed to these voyages of discovery. Like the pioneering exploration and 
research of Captain Cook aboard the first Resolution, these volumes are a credit to the human spirit, which sees 
no boundaries. 

The papers in this volume are published in a new online format that will be archived on CD-ROM. The 
Proceedings contents are available to students, scientists, and the public throughout the world. Volumes, once 
housed in the libraries of the member nations of ODP, are now published on the Internet for a worldwide 
audience and are also available in CD-ROM format. This electronic publication enables future investigators to 
gain easier access to the results of ocean drilling research. I acknowledge and thank the authors for their 
contributions and willingness to participate in this new venture.

Each Scientific Results volume has an Editorial Review Board that is responsible for obtaining peer reviews of 

papers submitted to the volume. This board usually is made up of the two co-chief scientists for the cruise, the 
ODP staff scientist for the cruise, and one external specialist who is familiar with the geology of the investigated 
area. ODP staff coordinate the peer-review process and also edit and produce each paper. 

Each Scientific Results volume contains one leg synthesis paper and other peer-reviewed papers that present the 
results of extensive research in various aspects of scientific ocean drilling related to each leg. Each paper 
submitted to a Scientific Results volume undergoes rigorous peer review by at least two specialists in the author’s 
research field. Volumes may also contain short reports of useful data. These Data Reports do not include 
interpretation of results and are peer-reviewed by at least one specialist. We seek to maintain a peer-review 
system comparable to those of the most highly regarded journals in the geological sciences.

To acknowledge the contributions made by this volume’s Editorial Review Board, the Board members are 
designated Editors of the volume. Reviewers of manuscripts for this volume, whose efforts are so essential to the 
success of the publication, are listed without attribution to any particular manuscript.
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On behalf of the Ocean Drilling Program, I extend sincere appreciation to the members of the Editorial Review 
Board and to the reviewers for generously contributing their time and effort. This process ensures that only 
papers of high scientific quality are published in the Scientific Results volumes.

Paul J. Fox
Director
Ocean Drilling Program
Texas A&M University
College Station, Texas 
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7. Data Report: Calcareous Nannofossil Stratigraphy at Sites 1088 and 1090
(ODP Leg 177, Southern Ocean)
Maria Marino and José Abel Flores

8. Data Report: Calcareous Nannofossil Data from the Eocene to Oligocene, Leg 177,
Hole 1090B
Maria Marino and José Abel Flores

9. Data Report: Oxygen Isotope Stratigraphy of ODP Leg 177 Sites 1088, 1089, 1090,
1093, and 1094
David A. Hodell, Christopher D. Charles, Jason H. Curtis, P. Graham Mortyn, Ulysses S. Ninnemann,
and Kathryn A. Venz

10. Data Report: Relative Abundance and Stratigraphic Ranges of Selected Diatoms
from Miocene Sections at ODP Sites 689, 690, 1088, and 1092 (Atlantic Sector
of the Southern Ocean)
Bernd Censarek and Rainer Gersonde

11. Data Report: Relative Abundance and Ranges of Selected Diatoms from Pliocene–
Pleistocene Sections of ODP Leg 177, Sites 1089–1094
Uli Zielinski and Rainer Gersonde
12. Data Report: Early–Mid-Pleistocene Oxygen Isotope Stratigraphy from the Atlantic
Sector of the Southern Ocean: ODP Leg 177 Sites 1094 and 1091
Helga Flesche Kleiven and Eystein Jansen

13. Data Report: Bulk Sediment Composition, Grain-Size, Clay, and Silt Mineralogy
of Pleistocene Sediments from ODP Leg 177 Sites 1089 and 1090
Gerhard Kuhn and Bernhard Diekmann

14. Data Report: Early and Mid-Pleistocene (MIS 65–11) Summer Sea-Surface Temperature, 
Foraminiferal Fragmentation, and Ice-Rafted Debris Records from the Subantacrtic
(ODP Leg 177 Site 1090)
Sabine Becquey and Rainer Gersonde
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of selected data tables. A complete listing of the ASCII data 
tables can be found below.

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, clicking on a filename with a .TXT extension will launch the Notepad application. You can 
configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 

on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Chapter 2
Chapter 6
Chapter 7

Chapter 8
Chapter 9
Chapter 12

Chapter 13
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Chapter 2
Table T1. Biogenic opal concentrations, Sites 1093 and 1094.

Chapter 6
Table T2. Original and averaged shipboard GRA bulk density values.
Table T4. Shipboard spectral reflectance values given as percent reflectance in 100-nm intervals.
Table T5. Weight percent CaCO3 values.

Chapter 7
Table T1. Distribution of Miocene to Pliocene calcareous nannofossils at Site 1088.
Table T2. Miocene to Pliocene distribution of calcareous nannofossils at Site 1090.

Chapter 8
Table T1. Distribution of Eocene to Oligocene calcareous nannofossils in Hole 1090B.

Chapter 9
Table T1. �18O and �13C for the benthic foraminifer Cibicidoides at ODP Site 1088 and weight percent 
CaCO3 of the sediment.

Table T2. �18O and �13C for the benthic and planktonic foraminifers, CaCO3, and percent 
fragmentation of planktonic foraminifers, Site 1089.

Table T4. �18O and �13C of benthic and planktonic foraminifers and CaCO3 at Site 1090 and piston 
core TTN057-6.

18 13
Table T6. � O and � C of N. pachyderma (s), Site 1093.
Table T7. �18O and �13C of N. pachyderma (s), Site 1094.

Chapter 12
Table T1. �18O for the planktonic foraminifer N. pachyderma (s), Site 1094.
Table T3. �18O for the planktonic foraminifer N. pachyderma (s), Site 1091.

Chapter 13
Table T1. Sediment composition, Polarstern core PS2821-1.
Table T2. Sediment composition, Site 1089.
Table T3. Sediment composition, Polarstern core PS2489-2.
Table T4. Sediment composition, Site 1090.
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CD-ROM CONTENTS: OVERSIZED MATERIAL
These oversized tables are available in PDF format:

Chapter 7
Table T1. Distribution of Miocene to Pliocene calcareous nannofossils at Site 1088.
Table T2. Miocene to Pliocene distribution of calcareous nannofossils at Site 1090.

Chapter 8
Table T1. Distribution of Eocene to Oligocene calcareous nannofossils at Hole 1090B.

Chapter 10
Table T2. Stratigraphic occurrence and relative abundance of selected Miocene diatom species, Site 
1092.

Table T3. Stratigraphic occurrence and relative abundance of selected Miocene diatom species, Hole 
689B.

Chapter 11

Table T1. Stratigraphic occurrence and relative abundance of diatom taxa from the Pliocene and 
Pleistocene, Site 1089.

Table T2. Stratigraphic occurrence and relative abundance of diatom taxa from the Pliocene and 
Pleistocene, Site 1090.

Table T3.  Stratigraphic occurrence and relative abundance of diatom taxa from the Pliocene and 
Pleistocene, Site 1091.

Table T4. Stratigraphic occurrence and relative abundance of diatom taxa from the Pliocene and 
Pleistocene, Site 1092. 

Table T5. Stratigraphic occurrence and relative abundance of diatom taxa from the Pliocene and 
Pleistocene, Site 1093.

Table T6. Stratigraphic occurrence and relative abundance of diatom taxa from the Pliocene and 
Pleistocene, Site 1094.
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 177 Site Map

ODP Map (Legs 100–177)

DSDP Map (Legs 1–96)

CD-ROM CONTENTS: INDEX TO LEG 177 INITIAL 
REPORTS AND SCIENTIFIC RESULTS VOLUMES
The index covers both the Initial Reports and Scientific Results portions of Volume 177 of the 

Proceedings of the Ocean Drilling Program. The index contains a subject and taxonomic index.

Index to Leg 177

CD-ROM CONTENTS: COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program contains the indexes of 
Volumes 101–178, and 180. The indexes are contained in the directory titled ODPINDEX and are 
named ###NDX.PDF (### = the leg number). These indexes can be searched individually or 
collectively. For information on using the Acrobat search function, see “Searching a PDF Document” 
in README.PDF.
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CD-ROM DIRECTORY STRUCTURE

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

177SR.PDF
(Preliminary pages and table of contents)

README.TXT

SR177_01.PDF  (Data Report: Sediment 
Geochemistry at Site 1089)

VOLUME
(Leg 177 Scientific Results volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(Information about the volume CD-ROM in ASCII format)

MAPS
(Drilling location maps)

ODPMAP.PDF
(ODP map, Legs 100 through 177)

CHAPTERS
(Volume chapters)

177_MAP.PDF
(Leg 177 site map)

SR177_02.PDF  (Data Report: Late Pleistocene 
Biogenic Opal)

SR177_03.PDF (Bacterial Abundances and Pore
Water Acetate Concentrations)

SR177_04.PDF (Late Eocene Impact Deposits)

SR177_05.PDF (Data Report: Pliocene Ice-Rafted
 Debris)

SR177_06.PDF (Data Report: CaCO3 
Stratigraphy and Diffuse Spectral Reflectance)

SR177_07.PDF (Data Report: Calcareous 
Nannofossil Stratigraphy)

SR177_08.PDF (Data Report: Eocene–Oligocene
Calcareous Nannofossils)

SR177_09.PDF (Data Report: Oxygen Isotope
Stratigraphy)

DSDPMAP.PDF
(DSDP map, Legs 1 through 96)

TABLES
(Selected ASCII tables)

SR177_02 (Chapter 2 file)

SR177_06 (Chapter 6 files)

SR177_07 (Chapter 7 files)

SR177_08 (Chapter 8 files)(Continued on next page)

MAC

WINDOWS

UNIX

SYNTH
(Overview chapter)

SR177SYN.PDF  (Leg 177 Synthesis: Southern
Ocean Paleoceanography)

SR177_10.PDF (Data Report: Miocene Diatom
Stratigraphy)

SR177_11.PDF (Data Report: Pliocene–
Pleistocene Diatom Stratigraphy)

SR177_12.PDF (Data Report: Early–Mid-
Pleistocene Oxygen Isotope Stratigraphy)

SR177_13.PDF (Data Report: Bulk Sediment
Composition)

SR177_14.PDF (Data Report: SSST, Foraminiferal
Fragmentation, and IRD)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 178NDX.PDF and
180NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

VOLUME
(Continued)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
177 Scientific Results)

177NDX.PDF
(177 Proceedings volume index)

TABLES
(Continued)

SR177_09 (Chapter 9 files)

SR177_12 (Chapter 12 files)

README.TXT

OVERSIZE
(Large-format tables)

SR177_07 (Chapter 7 files)

SR177_08 (Chapter 8 file)

SR177_13 (Chapter 13 files)

SR177_10 (Chapter10 files)

SR177_11 (Chapter 11 files)

README.TXT
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